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This guide introduces Cisco WebExTM Meeting CenterTM, provided by InterCall, provides 
basic information about using its many features. Refer to the table below to locate the 
feature or task you want to learn about. Feature descriptions and step-by-step procedures 
are grouped under the larger meeting task you are performing, such as scheduling a 
meeting, sharing information, or housekeeping and management tasks (for example, 
muting and un-muting microphones). 

Set Up Tasks 
 

Logging In And Out 
You must log in to your Cisco WebEx Meeting CenterWebsite to schedule and start your 
meetings and access your account features. Your site administrator provides you with 
your user name and default password for your account. 
 
To log in to Cisco WebEx Meeting Center: 
 

1 Go to your Cisco WebEx Meeting Center Website. The address for your site is 
usually in the following format: 
<your_company>.webex.com 

2 On the navigation bar, click Log In. 
3 Provide your user name and password. 
4 Optional. To automatically log in to Cisco WebEx Meeting Center whenever you 

access it, click the Remember user name and password check box. 
5 Click Log In. 

 
To log out from Cisco WebEx Meeting Center: 
To log out from your Cisco WebEx Meeting CenterWeb site, on the navigation bar at the 
top of the page, click Log Out. 

Setting Up Meeting Manager For Windows 
Meeting Manager is a software program that you install on your computer and use when 
participating in a meeting. Meeting Manager provides the options that you use to share 
information—such as presentations and applications—send chat messages, send and 
receive live video, take notes, record a meeting, and so on. 
 
The Meeting Manager software provides the work space for your meeting. 
 

 
System Requirements 
Your system must meet these requirements for installing Meeting Manager for Windows: 



  

 Microsoft Windows 95, 98, ME (Millennium Edition), XP, NT, 2000, or Windows 
Server 2003 
 Intel or AMD 400 MHz processor 
 128 MB RAM (64 MB recommended) 
 Microsoft Internet Explorer 5 or 6, Netscape 7, Mozilla 1.6, or Firefox 1.0 
 JavaScript and cookies enabled on the Web browser 
 56K or faster Internet connection 

 
If you want to share a presentation that was created using Microsoft® PowerPoint 2002 for 
Windows XP, an Intel Celeron or Pentium 500 MHz or faster processor is highly 
recommended. However, you cannot share other types of presentation or documents 
unless you either: 

 Sign in to your computer as an administrator before starting or joining a meeting for 
the first time, or 
 Have a Windows NT or 2000 administrator set up your computer for you. 

 
Subsequently starting or joining an event does not require administrator privileges. 
 
To set up Meeting Manager for Windows: 
 

1 On the navigation bar, expand Set Up, and then click Meeting Manager. The Set 
Up page appears. 

2 Click Set Up. 
3 If a security dialog box appears, do one of the following: 

- If you are installing Meeting Manager on Microsoft Internet Explorer, click Yes. 
- If you are installing Meeting Manager on Netscape Navigator, click 
- Grant. Setup continues. A progress message box appears, indicating the 

progress of setup. 
- Once setup is complete, the Setup Complete page appears. 

4 Click OK. 
 
As a Host or Presenter, you can now schedule, start, or join a meeting. 

 
Schedule a Meeting 
 

Schedule Your Meetings  
Using Meeting Center, you can set up: 
 

 Scheduled meetings (using either the Quick Scheduler or the Advanced Scheduler) 
 Audio Only meetings 
 One-Click Meetings 

 
 
 
 
 



  

 
Start a Meeting 
 

Starting The Meeting As A Host Or Presenter   
Using the One-Click Meeting Setup Wizard, you can specify options for an unscheduled 
meeting, and then start the meeting at any time, by clicking the One-Click Meeting link on 
your Cisco WebEx Meeting Center navigation bar. If you also install the WebEx One-Click 
program, you can start your One-Click Meeting from the WebEx One-Click panel, or by 
clicking one of your One-Click shortcuts, which appear on: 

 Your Web browser toolbar (Internet Explorer only) 
 The WebEx menu in Microsoft Office applications 
 The right-click menu for files and applications on your desktop 

 
To set up a One-Click Meeting: 

1 Log in to your Cisco WebEx Meeting Center Web site. 
2 On the top navigation bar, click My WebEx. 
3 Click the One-Click Meeting tab. 
4 Use the One-Click Meeting Setup Wizard to specify information about the 

meeting. 
5 Click Finish. 

- The Download One-Click screen appears. 
 

6 Optionally install WebEx One-Click: 
- Click Download One-Click. 
- Save the WebEx One-Click installation program to your computer, and then run 

it. 
- Follow the instructions in the installation program. 

 
To start a One-Click Meeting from your Cisco WebEx Meeting Center Web site: 

1 Log in to your Cisco WebEx Meeting Center Web site. 
2 On the left navigation bar, click Host a Meeting > One-Click Meeting. 

 
To start a One-Click Meeting using the WebEx One-Click panel:  

1 Click the WebEx One-Click icon on either your desktop or taskbar. 

                                        

   

2 On the WebEx One-Click panel, click Start Meeting. 

Taskbar icon 
Desktop icon 



  

 

 
To start a One-Click Meeting using a One-Click shortcut: 
Click one of these One-Click Meeting shortcuts, which the WebEx One-Click installation 
program set up on your computer: 
 

 Web browser button 
 

  
A Start One-Click Meeting button appears on the toolbar 
on your Internet Explorer Web browser. 

     

 
 WebEx menu in Microsoft Office applications 

 
One-Click Meeting commands appear on a WebEx menu in your 
Microsoft Office applications. These commands let you 
automatically share in a meeting the application or any document 
that is open in the application. 
 
 
 

 Shortcut (right-click) menu for document files and applications 
 

 
One-Click Meeting commands appear on the 
shortcut menu when you right-click the icon for any 
application or document file. These commands let 
you automatically share the application or document 
in the meeting. 
 
 
 

 
To edit One-Click Meeting settings: 
 

1 Log in to your Cisco WebEx Meeting Center Web site. 
2 On the navigation bar, click My WebEx. 
3 Click the One-Click Meeting tab. 
4 Use the One-Click Meeting Setup Wizard to set new options. 

 



  

 
Running a Meeting – Sharing, the Core of your Meeting 
 

Sharing Options  
Cisco WebEx Meeting Center provides you with a variety of options for sharing 
information in a meeting. The following table describes the advantages and 
disadvantages among these options. 
 
 
Sharing Option Advantages Disadvantages 
Presentation and 
Document Sharing 

 Is faster and more 
bandwidth efficient than 
application or desktop 
sharing. 
 Is ideal for sharing 
presentations or 
documents that you do not 
want to edit during the 
meeting. 
 Lets you and participants 
annotate content. 

 Does not let you edit 
the content during 
the meeting. 

 

Application Sharing  Lets you edit the content of 
any presentation or 
document open in the 
application. 
 Lets you grant Attendees 
control of the application. 
 Is ideal for software 
demonstrations. 
 Lets you and Attendees 
annotate the application 
and documents that are 
open in it. 

 Requires more 
bandwidth than 
presentation or 
document sharing. 

Desktop Sharing  Lets you quickly share 
multiple applications at 
once. 
 Lets you show any part of 
your desktop, including file 
directories. 
 Lets you grant Attendees 
control of your desktop, 
access files, and run 
applications. 
 Lets you and Attendees 
annotate your desktop and 
any applications. 

 Requires the most 
bandwidth among 
sharing options.  
 Lets an Attendee with 
remote control 
access any part of 
your computer and 
modify any files, 
which may be a 
security concern. 

Web Browser Sharing  Lets you guide Attendees 
to various Web pages and 
sites on the Web. 
 Lets you grant Attendees 
control of your Web 

 Does not display 
media effects or 
transmit sounds on 
Web pages.  
 Does not let 



  

browser. 
 Lets you and Attendees 
annotate Web pages. 

Attendees interact 
with Web pages 
independently. 

Web Content Sharing  Displays media effects and 
transmits sounds on Web 
pages. 
 Lets Attendees interact with 
Web pages independently. 

 Does not let you 
guide participants to 
other Web pages. 

 
Sharing Documents And Presentations 
You can share one or more presentations or documents you have created using word 
processing, presentation, or graphics programs. Document and presentation sharing is 
ideal for presenting information that you do not need to edit during the meeting, such as a 
slide presentation. 
 
Attendees view the shared document or presentation in their content viewers. 
They do not need to have the applications used to create the documents available on 
their computers. Attendees can also view any animation and transition effects on shared 
Microsoft PowerPoint slides. 
 
Once a meeting starts, you can open a document or presentation to share. You do not 
need to select it or “load” it before the meeting. 
 
While sharing a document or presentation, you can: 

 Make annotations 
 Use a pointer to emphasise text or graphics 
 Save it to a file 
 Print it 
 Display it at various magnifications, in miniature (thumbnails), and in a full-screen 
view 
 Synchronise all participants’ displays with the display in your content viewer 

 
At any time during a meeting, you can grant Attendees privileges that allow them to 
annotate, save, print, and display different views of shared presentations or documents. 
 
To share a document or presentation: 

1 On the Share menu, choose Presentation or Document. The Share Presentation 
or Document dialog box appears. 

 
2 Select the document or presentation that you want to share. 
 
3 Click Open. 

 
The shared document or presentation appears in the content viewer, as in the example 
below: 
 



  

 

 
 
TIP: For tips that can help you to share documents and presentations more effectively, see 
“Tips for sharing software” on page 20. 

Accessing Tools For Sharing                
As you start sharing documents and applications during your meeting, tools are available 
at your fingertips. 
 
In this example, the Host has opened a presentation to share with meeting participants. 
 
Notice the changes in the window. You now have access to: 
 

 Annotation tools for highlighting and referring to elements in the presentation or 
application you are sharing 
 View tools for displaying document and presentations in different ways, such as 
showing thumbnails of the pages  
 Previous and Next buttons, for moving around in a document 

 

 

 

 

 

 

 



  

 
Annotation Tools  

 

 
 
 

View Tools 
 

 

Sharing whiteboards 
 
 
Sharing a whiteboard allows you to draw objects and type text that all Attendees can see 
in their content viewers. You can also use a pointer to emphasise text or graphics on a 
whiteboard.  
 
While sharing whiteboard, you can: 

 Display it at various magnifications, in miniature (thumbnails), and in a full-screen 
view 
 Save it 
 Print it 
 Synchronise Attendee’s displays with the display in your content viewer  

 



  

 
If you grant annotation privileges to Attendees, you and Attendees can draw and type on 
a whiteboard simultaneously. You can also allow Attendees to save, print, and display 
different views of shared whiteboards.  
 
To share a whiteboard:  
On the Share menu, choose Whiteboard.  
 
When sharing a whiteboard: 

 You can add multiple pages to a shared whiteboard. For details, consult the users’ 
guide or online Help. 

 
You can share multiple whiteboards. For each whiteboard that you share, Meeting 
Manager creates a new Whiteboard tab in the content viewer.  

Sharing Multimedia In A WebEx Meeting  
During a meeting, you can share the following types of media files in the content viewer: 

 WebEx Recording Format (WRF) files 
 video files 
 audio files 
 Flash movie and interactive Flash files 
 Web pages  

 
You can share media files in either of two ways: 

 In a Microsoft PowerPoint presentation—You can share media files that play on 
Microsoft PowerPoint slides. Using the WebEx Universal Communications Toolkit, 
a plug-in for Microsoft PowerPoint, you can insert UCF media objects into your 
slides. Depending on the options you choose in the toolkit, the media object can 
either: 
- link to a media file that resides on your computer, another computer on your local 

network, or a remote server 
- contain a media file as part of your presentation file  
 
You can download the Universal Communications Toolkit from your meeting 
service Web site. For information about using the Universal Communications 
Toolkit, refer to the guide Getting Started with WebEx Universal Communications 
Toolkit, which is available on your Cisco WebEx Meeting CenterWeb site. 
 
 As a standalone file—You can share a media file directly in the content viewer. 
Meeting Manager creates a UCF media object for the file automatically, which 
appears in the content viewer.  

 
A UCF media object contains options and controls that you can use to display or 
manipulate its associated media file.  
 
For more information about how UCF works, consult the Cisco WebEx Meeting 
Center User’s Guide or online Help.  

Granting Document, Presentation, And Whiteboard Sharing Privileges  
By default, only the Presenter can share a document, presentation, or whiteboard during 
a meeting. However, you can allow all Attendees or individual Attendees to share their 
own presentations or documents or interact with pages, slides, and whiteboards that 
others share. You can also remove these sharing privileges from Attendees at any time.  



  

 
To specify Attendee privileges for shared content in the content viewer: 
 

1 In the Meeting window, on the Participant menu, choose Assign Privileges. The 
Attendee Privileges dialog box appears. 

 
2 Do one of the following: 

-  To grant privileges to or remove them from all Attendees at once, in the pane on 
the left, select All Attendees. 

-  To grant privileges to or remove them from an individual Attendee, in the pane on 
the left, expand All Attendees, and then select the Attendee's name. 

 
3 On the Participants tab, under Document, select or clear the check boxes for any 

of the following sharing privileges that you want to grant to or remove from all 
Attendees, respectively: 

-  Save 
-  Print 
-  Annotate 
 

4 On the Participants tab, under View, select or clear the check boxes for any of 
the sharing privileges that you want to grant to or remove from all Attendees, 
respectively: 

-  Thumbnails 
-  Any page 
-  Any document 
 

5 On the Participants tab, under Meeting, select or clear the Share documents 
check box to grant to or remove the privilege from all Attendees, respectively. 

6 Click Assign. 

Sharing Software  
When you share software, Attendees can follow all actions that you take. You can also 
annotate the software, or let an Attendee annotate it or control it remotely.  
 

 You can share these types of software with Attendees: 
 Applications on your computer 
 Your computer’s desktop 
 Web browsers 
 Remote computers, if you installed the Access Anywhere Agent on the computer  

 
To share an application: 
 

1 On the Share menu, choose Application.  
 
The Share Application dialog box appears, showing a list of all applications currently 
running on your computer. 
  



  

 

 
 

2 Optional. To view a list of applications that are installed on your computer, but not 
currently running, click View Application.  
Use this option to locate an application you want to share, but are not currently 
using.  

 
3 In the list, select the application that you want to share. 
4 Click Share.  

Your application appears in a sharing window on Attendees' screens.  

Letting An Attendee Remotely Control Shared Software  
 
While sharing the following types of shared software, you can let an Attendee control it 
remotely: 

 Application 
 Desktop 
 Web browser 

 
An Attendee who has remote control of shared software can interact with it completely. 
While an Attendee is remotely controlling your shared software, your mouse pointer is 
inactive. At any time, however, you can reassume control of a shared application and 
regain use of your mouse pointer.  
 
While you are sharing software, any Attendee can send a request to control the software 
remotely. You can then grant control to the Attendee. Alternatively, you can automatically 
grant control of shared software to any Attendee who requests remote control.  
 
You can stop an Attendee from remotely controlling shared software at any time.  
 
To let an Attendee remotely control shared software: 
 

1 Do either of the following: 
 

-  On the title bar of a window that you are sharing, on the Sharing menu, point to 
Allow to Control Remotely.  

 



  

 
 

-  In the lower-right corner of your computer’s desktop, on the Sharing menu, point 
to Allow to Control Remotely.  

 
 

2 Select the name of the Attendee whom you want to control the software.  

Sharing Your Desktop  
Desktop sharing lets you show all your computer’s entire desktop—including any 
applications and windows that are currently open— and all the actions that you take with 
your desktop. Desktop sharing can be useful for technical support. For example, you can 
allow a technical support representative to access your computer and fix a problem as 
you watch.  
 
While sharing your desktop, you can: 

 Control Attendees’ views of your desktop. 
 Annotate your desktop, using a highlighter tool. 
 Let an Attendee control your desktop remotely. For example, you can let an 
Attendee edit a document on your computer. 
 Let an Attendee annotate your desktop remotely.  

 
To share your desktop:  
On the Share menu, choose Desktop.  
 
Your desktop appears in a sharing window on Attendees' screens.  
 
To allow an Attendee to control your desktop remotely: 

1 On the title bar of an application you are sharing, on the Sharing menu, point to 
Allow to Control Remotely. 

2 Select an Attendee to control your desktop.  

Transferring Files During A Meeting  
As a Presenter, you can publish files that reside on your computer during a meeting. For 
example, you can provide Attendees with a document, a copy of your presentation, an 
application, and so on. Published files appear in each Attendee’s Meeting window, 
allowing them to download the files to their computers.  
 
To transfer files during a meeting: 

1 On the File menu, choose Transfer. The File Transfer window appears. 
2 Click Share File. 
3 Select the file that you want to publish, and then click Open. 
4 Optional. Repeat steps 2 and 3 to publish additional files. The files appear in the 

File Transfer window in each participant’s Meeting window  
 
 
 
 
 



  

Interacting with Attendees 
 

Working With The Panels  
Using the panels on the right side of the Meeting window, you can chat with Attendees, 
poll them, send video. These panels are very flexible. You can expand, close, or minimise 
them quickly and easily. You can also reduce the panels to icons, providing greater space 
for sharing documents, applications, and other items with meeting participants.  

Panel Overview  
Your service selects which panels display initially. 

  
 
 
 
To organise the floating panels: 
As you reopen the panels to jot a few notes or chat with a participant, you may find you 
need to arrange the panels. 
 

1 On the floating icon tray, click the Select Panel button.  
 
It is the last button on the floating icon tray. 

 
2 On the Select Panel menu, choose Open Right Panel.  
 
An empty panel appears on the right side of the screen.  

To display the Select 
Panel menu, click Panels.  

In this example, the 
Polling panel is 
minimized. Click Polling 
in the icon tray to restore 
it. 

The Video panel is collapsed. 
Use the icon on the left side 
of the panel title bar to 
collapse or expand a panel. 

You can minimize all the 
panels at once using the 
Minimise All command.



  

 
The icon tray now resides at the top of the right panel. 

Sharing And Full-Screen View  
In full-screen view, you have access to sharing and viewing options from the Select Panel 
menu. 
 
If you are sharing a document  
If you have already opened several documents, you can switch to share any of these 
documents.  
 
To display a different document: 

1 On the floating icon tray, click the Select Panel button. It is the last button on the 
floating icon tray. 

2 On the Select Panel menu, choose Select Document. You see a list of 
documents that are currently open in this meeting. 

3 Select the document you want to share. 
 

 
To select another sharing option: 

1 In the floating icon tray, click the Select Panel button.  
2 On the Select Panel menu, choose Share. You see the list of sharing commands. 
3 Choose the kind of sharing you want to do.  

 
To resize the display of Attendees to match your display: 

1 On the icon tray above the panels, click the Select Panel button. It is the last 
button on the floating icon tray. 

 
2 On the Select Panel menu, choose View > Synchronise Views. 

 
All Attendees’ displays now match your display. 
 

If you are sharing a desktop  
 
To select another sharing option: 
 

1 On the floating icon tray, click the Select Panel button. It is the last button on the 
floating icon tray. 

2 On the Select Panel menu, choose Share.  
a. You see the list of sharing commands 

3 Choose the kind of sharing you want to do. For details about these options, see 
Sharing documents and presentations and Sharing software.  

 
To resize the display of Attendees to match your display: 

1 On the floating icon tray, click the Select Panel button.  
a. It is the last button on the floating icon tray. 

2 On the Select Panel menu, choose View > Synchronise Views. 
 
All Attendees’ displays now match your display.  

Panel Alerts  



  

If you have closed, minimised, or collapsed any panels, you will see an alert if a panel you 
no longer can see requires your attention.  
 
Some reasons for seeing alerts: 
 

A participant arrives or leaves a meeting 
 A Raise Hand indicator appears in the Participants list 
 The note taker publishes notes 
 An Attendee sends a chat message 
 A poll opens or closes 
 Poll answers are received  

 
Alerts For Closed Panels  
If you have closed a panel, the Panels button changes colour to alert you to a change. For 
example, if a participant leaves your meeting, and you have closed the Participants panel, 
the Select Panel menu button turns into an alert. 
 

 

 
Alerts For Minimised Panels  
If you have minimised a panel, the icon representing that panel alerts you of a change. 
 

The Chat icon changes colour to let 
you know you have a new chat 
message. 

 

 

 

 
Alerts For Collapsed Panels  

Panels button changes color to alert you.  
In this example, a participant has left the 
meeting.  The Participants panel is 
closed, so an alert is sent. 

The panel requiring attention is 
highlighted. 



  

If you have collapsed a panel, the Expand/Collapse icon changes colour when you need 
to pay attention to that panel. 
 

The icon changes colour to let you know you 
should check the contents of this panel. 
 
 

 

Understanding the Participants Panel 
 
 
In addition to the list of people currently attending your meeting, the Participants 
panel provides other information about the Attendees. 
 
 
 
 
 

 
 

The following table describes the possible indicators that may appear in the 
participant list. 
 

Sending A Chat Message To Participants  
 
To send a chat message:  
 

1 In the Meeting window, open the Chat panel. 
2 Type a message in the Chat box. 
 
3 In the Send to drop-down list, select the recipients of the message. 

Integrated VoIP Participant 

Ask to 
speak

Note Taker 

Annotation Color 

Presenter 

Host 
Speaker  
(integrated VoIP) 

 Participant 
Ready  

Speaker is not 
muted 
(teleconference)

Muted Speaker 
(teleconference) 

Active Talker 
indicator  



  

 
 
Select the recipients of your chat 
message.  
 
To send a message to everyone, 
including the Host, Presenter, and 
Attendees, chooses All Participants  
 
To send to everyone except the Host 
and panellists, choose All Attendees.  
 
To send a chat message to a particular 
participant, select the name in the list.  
 
 
 
 
 
 
 
 
 

4 Click Send.  
 

The recipients receive the chat message in their chat viewer.  

About Taking Notes  
During a meeting, one or more meeting participants with access to the notes feature can 
take notes on the Notes or Closed Caption panel in the Meeting window. Only one 
participant transcribes closed captions.  
 
If all participants with access take notes, they cannot publish their notes to others during 
the meeting. However, participants can save their notes at any time during the meeting.  
 
If only a single participant can take notes or perform closed captioning, the Meeting Host 
can select the single note taker or closed caption provider during the meeting. A single 
note taker can publish notes at any time during the meeting or send a meeting transcript 
containing the notes to all participants. A closed caption provider can publish captions in 
real-time during the meeting and can also send a transcript containing the captions to all 
participants.  

Taking Personal Notes  
If the Meeting Host or Presenter has selected the option to allow participants to take 
personal notes, you can type your notes on the Notes panel in the Meeting window.  
 
To take personal notes: 

1 In the Meeting window, open the Notes panel. 
2 Type your notes in the box.  

 
Note: You can save your notes to a text file on your computer. For details, see Saving notes to 
a file.  



  

 
Taking Public Notes (Meeting Minutes)  
If the Meeting Host has designated you as the single note taker for a meeting, you can 
type notes on the Notes panel in your Meeting window. Your notes are not visible to other 
meeting participants until you publish them. You can publish your notes at any time during 
the meeting, or you can send your notes in a meeting transcript to all participants.  
 
To take public notes: 

1 In the Meeting window, open the Notes panel. 
2 Type your notes in the box. 
3 Optional. To publish your notes, so they appear in each participant's Notes panel, 

click Publish. 
 
Note: For details about sending public notes in a meeting transcript, see Sending a meeting 
transcript to participants.  
 
Saving Notes To A File  
If you are taking personal or public notes or closed captions during a meeting you can 
save your notes to a text file on your computer. You can also save any notes or closed 
captions that another note taker or   publishes on your Notes or Closed Caption panel.  
 
Once you save new notes to a file, you can save changes to the notes or save a copy of 
the notes to another file.  
 
To save new notes:  

1 In the Meeting window, perform either task:  
-  On the Notes or Closed Caption panel, click Save. 
-  On the File menu, point to Save, and then choose Notes or Closed Captions.  
 

The Save Notes As dialog box appears. 
2 Choose a location at which to save the file. 
3 Type a name for the file. 
4 Click Save. 

 
Meeting Manager saves the file at the location you chose. Its file name has a .txt 
extension.  
 
To save changes to notes:  
In the Meeting window, do either of the following: 

 On the Notes or Closed Captions panel, click Save. 
 On the File menu, point to Save, and then choose Notes or Closed Captions.  

 
Meeting Manager saves the file at the location you chose. Its file name has a .txt 
extension.  
 
To save a copy of notes to another file: 

1 In the Meeting window, on the File menu, point to Save As, and then choose 
Notes. The Save Notes As dialog box appears. 

2 Do either or both of the following: 
-  Type a new name for the file. 
-  Choose a new location at which to save the file. 
 

3 Click Save.  
 



  

 
Meeting Manager saves the file at the location you chose. Its file name has a .txt 
extension. 
 

Tip: Alternatively, you can save all of the following meeting information to files at once: 
 shared presentations or documents 
 chat messages 
 poll questionnaire 
 poll results 
 notes  

 
To save all information at once, on the File menu, choose Save All. In this case, 
Meeting Manager uses the default file names for the files. Thus, if you have already 
saved a file using another name, Meeting Manager does not overwrite that file.  

Setting Up Video  
To set up video, you must connect a video camera—also called a webcam— to your 
computer. Once you start or join a meeting, Meeting Manager automatically detects your 
video camera.  

Sending Live Video  
If the single-point video option is turned on, only the Presenter or another participant 
selected by the Presenter can send live video. If the multipoint video option is turned on, 
up to six participants whose computers have a video camera can send video. Only the 
Presenter or another participant selected by the Presenter can send live video. 
 
To send live video: 
In the Meeting window, display the Video panel on the right side of the Meeting window. 
For details about using the panels, see Working with the panels.  
 
Meeting Manager begins sending live video immediately. To send live video, you must 
connect a video camera to your computer.  
 
For details, see consult the documentation that accompanied your camera.  

Polling Attendees  
To take a poll, you must first prepare a poll questionnaire. You can prepare a 
questionnaire at any time during a meeting. Or, to save time during a meeting, you can 
prepare a questionnaire before the meeting starts, save it, and then open it during the 
meeting.  
 
Once Attendees complete a poll, you can view the results and share them with Attendees. 
You can also save the results of a poll for viewing outside of a meeting.  

Preparing A Poll Questionnaire  
During a meeting, you can prepare a poll questionnaire that includes multiple-choice 
answers. Once you complete a questionnaire, Attendees can respond to it during a 
meeting. 
 



  

 

 
 
 
Sending A Meeting Transcript To Participants  
As a Meeting Host, single note taker, or closed captions, you can send a transcript of a 
meeting in an email message to all participants at any time before the meeting ends. The 
transcript, which Meeting Manager creates automatically, contains the following 
information: 
 

 meeting topic 
 meeting number 
 meeting starting and ending times 
 the list of all participants 
 the meeting agenda 
 any public notes or closed captions that you took during the meeting, if you saved 
them to a file  

 
You can optionally attach any of the following files to the transcript message, if you saved 
them during the meeting: 
 

 shared documents 
  poll questionnaire 
 poll results 
 chat messages 
 public notes or closed captions 

 
For security purposes, each transcript email message that a participant receives does not 
display the email addresses for other participants.  
 
Important: To receive a transcript email message, a participant must provide his or her email 
address when joining the meeting.  
 
 
To send a meeting transcript to participants: 
 

1 On the File menu, choose Send Transcript. 
2 (Optional) To include any files or other data shared or presented in the meeting, 

select the “Attach meeting and data files” check box. 
 

Sample poll questions 



  

 

 
 

3 (Optional) Select the check box for any files that you want to attach to the 
transcript email message, and then click OK. 

4 In the new email message that appears, review the content and make any 
necessary changes. 

5 Send the transcript email message. 
 

Managing Meetings 
 
 
Participant Roles And Privileges  
Each participant in an online meeting has one of the following roles: Host, Presenter, or 
Attendee. These roles determine which options you can use on your Cisco WebEx 
Meeting CenterWeb site and in Meeting Manager. 
 
Role Responsibilities and options 
Host A Meeting Host must have a user account on your Cisco WebEx 

Meeting Center Web site. A Host can schedule, start, and control a 
meeting; and assign meeting roles to other participants. Initially, the 
Host is also the Presenter; however, the Host can make any 
participant the Presenter during the meeting. 

Presenter Only one participant at a time can be the Presenter, but participants 
can take turns being the Presenter during a meeting. A Presenter 
can: 

+  Share and annotate presentations, documents, and 
whiteboards 

+  Share software, and grant remote control of shared software 
to participants 

+  Assign meeting privileges to other participants 
+  Turn various meeting options on or off 
+  Poll participants 
+  Transfer files to participants 
+  Send live video, and select which participants can send video 

Attendee Attendee A meeting Attendee participates in a meeting but generally 
does not present information. Attendees can view shared 
information and interact with it, if the Presenter assigns the 
appropriate privileges to them. An Attendee can also perform other 
tasks, such as recording a meeting, if he or she has the appropriate 



  

privileges. 
 
About Granting Privileges To Attendees  
Once a meeting starts, all meeting Attendees automatically receive privileges: 
 

 If the Host scheduled the meeting and specified Attendee privileges, Attendees 
receive those privileges. 
 If the Host scheduled the meeting but did not specify Attendee privileges, 
Attendees receive the default privileges. 
 If the Host started an instant meeting, Attendees receive the default privileges.  

 
You can grant or remove privileges for the following meeting activities: 
 

 Document sharing, including privileges for saving, printing, and annotating shared 
content in the content viewer 
 Viewing miniatures, or thumbnails, of pages, slides, or whiteboards in the content 
viewer 
 Zooming in and out on pages, slides, and whiteboards in the presentation viewer 
 Viewing Any page, slide, or whiteboard in the content viewer, regardless of the 
content that the Presenter is viewing 
 Controlling full-screen view of pages, slides, or whiteboards in the content viewer 
Viewing the participant list 
 Chatting with participants 
 Recording a meeting 
 Requesting remote control of shared applications, desktops, or Web browsers 
 Contacting the operator for a teleconference privately, if your meeting service 
includes the private operator option  

 
Granting Attendee Privileges During A Meeting  
During a meeting, you can grant privileges to or remove them from all Attendees at once 
or an individual Attendee.  
 
To specify Attendee privileges during a meeting: 

1 In the Meeting window, on the Participant menu, choose Participant Privileges. 
The Attendee Privileges dialog box appears. 

 
2 Perform either task: 
 

-  To grant privileges to or remove them from all Attendees at once, in the pane on 
the left, select All Attendees. 

-  To grant privileges to or remove them from an individual Attendee, in the pane on 
the left, expand All Attendees, and then select the Attendee's name. 

 
3 Specify Attendee privileges: 
 

-  To grant a privilege to Attendees, select its check box.  
-  To grant all privileges to Attendees, select the Assign all privileges check box. 
-  To remove a privilege from Attendees, clear its check box. 
-  To reset to the preset meeting privileges, click Reset to Meeting Defaults. 

 
4 Click Assign.  



  

Controlling a meeting 
 
 
As a Meeting Host, you can control many aspects of an online meeting.  

Inviting Attendees To A Meeting In Progress  
Once you start a meeting, you can invite additional Attendees to the meeting. You can 
invite Attendees by phone, email, or instant message.  
 
Tip: If the Quick Start option is turned on, you can invite Attendees from the Quick Start tab as 
well as from the Participant menu  
 
To invite an Attendee by email to a meeting in progress: 

1 On the Participant menu, point to Invite, and then choose By Email. 
2 Type the Attendee’s email address. 
3 Click Send Invitation.  

 
Each person that you invite receives an invitation email message that contains 
information about the meeting—including the password—and a link that the Attendee can 
click to join the meeting. 

Designating A Presenter  
As a Meeting Host, you are initially the Presenter as well. However, you can designate 
any Attendee as the Presenter. You can also reclaim the Presenter role or change the 
Presenter at any time.  
 
To designate a Presenter: 

1 In the participant list on the Participants tab, select the name of the Attendee 
whom you want to designate as the Presenter. 

2 Below the participant list, click Presenter.  

Transferring The Host Role  
As a Meeting Host, you can transfer the Host role—and thus all control of the meeting—to 
an Attendee.  
 
To transfer the Host role: 

1 In the participant list on the Participants tab, select the name of the Attendee to 
whom you want to transfer the Host role. 

 
2 On the Participant menu, point to Make, and then choose Host.  

Expelling A Participant  
You can remove, or expel, a participant from a meeting at any time.  
 
To expel a participant: 

1 In the participant list on the Participants tab, select the name of the participant 
whom you want to expel. 

2 On the Participant menu, choose Expel.  



  

 
Locking And Unlocking A Meeting  
Once you start a meeting, you can restrict access to it, or “lock” it. This option prevents 
anyone else from joining the meeting. You can unlock a meeting at any time.  
 
To lock a meeting:  
On the Meeting menu, choose Restrict Access.  
 
To unlock a meeting:  
On the Meeting menu, choose Restore Access.  

Ending or leaving a meeting 
 
 
Once you end a meeting, the Meeting window closes on all participants’ screens. If the 
meeting includes an integrated voice teleconference, the conference also ends.  
 
To end a meeting: 

1 On the File menu, choose End Meeting.  
2 In the confirmation message that appears, click Yes.  

Viewing Usage Reports  
If your Cisco WebEx Meeting CenterWeb site includes the reports option, you can view 
the following types of usage reports: 
 

 Meeting Usage report —Contains detailed information about each meeting that you 
host, including information about each participant. 

 
 Access Anywhere Usage report —Contains detailed information about the 
computers that you access remotely and your Access Anywhere sessions, if your 
site or account includes the Access Anywhere option.  

 
To view a usage report: 

1 Log in to your Cisco WebEx Meeting CenterWeb site. 
2 On the navigation bar, click My WebEx. 
3 Click My Reports. 
4 Select the type of report you want to view. 
5 Specify a range of dates for which you want to view a report and how you want 

data sorted in the report. 
6 Click Display Report. 

 

 

 


